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HUDCAPS NAVIGATION GUIDE 
 

Section   1.   Introduction 

 
A.  The HUDCAPS Navigation Guide is designed to assist you the user in accessing and using 

HUDCAPS.  The instructions herein provides guidance on the usage of HUDCAPS in the 
Graphical User Interface (GUI) or Windows environment.  To use this Guide, your computer 
must have HUDware II  installed.  If you are not sure if you have HUDware II, please refer 
to Section 2 of this document, which describes in part, the HUDware II desktop.  If you don’t 
have HUDware II on your computer, contact User Assistance at (202) 708-3300. 

 

B. In addition to the HUDCAPS Navigation Guide, the following guidance materials are 
available to assist you with documents processing and information gathering  in HUDCAPS:  

1.  HUD Budget and Accounting Handbook Policies and Procedures Handbook - 
Prescribes budget execution and accounting policies and procedures applicable to all 
appropriations and funds of the Department. 

 

2. Budget Execution Data Entry Guide - Provides detailed instructions on entering budget 
execution documents into HUDCAPS,  accessing query tables to ascertain fund 
availability and other financial information, and an Appendix with examples of populated 
documents. 
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Section   2.   Signing on to HUDCAPS 

A. The following steps will allow access HUD’s Central Accounting and Program System 
(HUDCAPS): 

1. In HUDware II, click the Start button and point to Programs. Then point to Program and 
then click HUDCAPS for Windows. Users may also setup a desktop shortcut icon that 
can be double clicked on to access HUDCAPS for Windows. 

 

 
 
 

2.  The HUDCAPS Welcome screen will appear. 

 

 
 
 

NOTE The version and release numbers may differ from the numbers in the picture above as releases 
will continue to occur after the printing of this manual. Disregard any difference in numbers 
between the picture above and your system. 
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2.  Signing on to HUDCAPS (continued). 
 

NOTE    The HUDCAPS Notice Screen will  appear if enacted by the HUDCAPS System 
Administrator. This screen is  used to send messages pertaining to HUDCAPS that are 
relevant to users.  To close click on the applicable box. 

3.  Sign on to the Mainframe by entering your HUD User ID  and Password in the Mainframe 
Sign On dialog box. Once you have completed this, choose the OK button or press Enter 
to continue.  

 

 

 

 
4.  When the HUDCAPS Security dialog box appears, enter your HUDCAPS User ID and 

Password. Then, choose the OK button or press Enter to complete the sign on procedure 
. 
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Section   3.   Signing on to HUDCAPS for First Time Users 

A.  To access HUDCAPS for the first time, a HUDCAPS Systems Security Access Form must 
be completed by the first time user and forwarded to the appropriate offices as indicated on 
the form.  (Instructions for completion and submission provided on the form).   Upon 
approval and establishment in HUDCAPS,  you will be provided with a User Identification 
Number (H#####) and instructions for accessing HUDCAPS for the first time.   If you need  
more information on  this form, contact the appropriate individual in your office, or call 708-
3300.  For your use sign on instructions for first time users are provided below. 

1.  Click on Start, point to Programs, point to Program, and click on HUDCAPS for 
Windows.  

  
• The HUDCAPS Welcome screen appears. 
   
• The Mainframe Dialog Box appears.  

(Refer to Section 2 of this document for examples of these screens.) 

2. In the User ID Field, enter your User ID (H#####) 

3.  In the Password Field, enter the last six digits of your social security number and Press 
Tab. 

 
4.  In the New Password Field, enter the Password of your choice (6-8 Characters), Press 

Tab. 
  
5. In the Verify Field, enter the same Password , and select the OK button or press Enter. 

 
(Note:  The password entered and verified will be your password when signing on in the 
future. However,  the Mainframe Sign On password will have to be changed every 21 
days.  HUDCAPS will prompt you when to make the change.  Refer to Section 17 for 
instructions on how to change your password in 21 day intervals). 

• After a few moments, the HUDCAPS Security Dialog Box appears.  Your User ID 
will be pulled into this box from your Mainframe sign-on. 

6.  Tab to the Password Field and enter your User ID, Press Tab. 
  
7.  In the New Password Field enter new password (6-8 Characters), Press Tab. 

 
8. In the Verify Field enter the same password. 

 
(Note:  The same password used for your Mainframe sign-on can be used for the 

HUDCAPS Security dialog box sign-on, or it can be different.  There is no 
requirement to change this password every 21 days). 

9.  Choose the OK button or press Enter. 
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Section   4.   Main Menu 

A.  HUDCAPS uses a series of menus to simplify system navigation. These menus enable you to 
access tables and queries, enter data, and process documents. This section provides you with 
an overview of the Main menu and a listing of all the available drop-down menus. 

 

 
 

B. The Main menu provides the following drop-down menus: File, Edit, Options, Window, and 
Help. Additionally, Batch and Document menus are added when processing documents and 
an Action menu is added for table related transactions. Users can access the drop-down 
menus by clicking once on the desired selection from the Main menu, or use your keyboard 
to press the shortcut keys indicated to perform the desired action. Once accessed, each menu 
provides several selections.  ( These selections and their keyboard shortcuts are listed in the 
following section). 
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Section   5.   File Menu 

 
 

Menu Selection Keyboard Description

New/Open ⎯ Allows you to create a new document or open an 
existing document 

Close Ctrl + F4 Closes the active document 

Save ⎯ Saves the active document  

Create: Funding 
Increment 

⎯ Creates new Funding Increment (for Section 8 
funds only) 

Create: Reservation ⎯ Creates new Reservation (for Section 8 funds 
only) 

Create: Contract ⎯ Creates new Contract (for Section 8 funds only) 

Create: Reservation/ 
Contract Amendment 

⎯ Creates new Reservation or Contract Amendment 
(for Section 8 funds only) 

Document Listing... ⎯ Opens the Document Listing 

Submit Reports ⎯ Accesses the Report Listing 

Exit ⎯ Signs you off of HUDCAPS and returns you to 
HUDware II 
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Section   6.   Edit Menu 

 
 

Menu Selection Keyboard Description

Cut Ctrl + X Copies the selected data to the clipboard and then 
deletes the data in the field  

Copy Ctrl + C Copies the selected data to the clipboard without 
deleting the data from the field  

Paste Ctrl + V Copies the data previously Cut or Copied onto the 
clipboard into the selected field. Paste will repeatedly 
enter the information until a new Cut or Copy is 
made. 

Reset Del Resets radio buttons to their original state when the 
table was first opened 

Select all ⎯ Selects all lines on the current table or query. Select 
all can be used before an Add, Change, or Delete 
action  

Deselect all ⎯ Deselects all selected lines on the current table or 
query  
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Section  6. Edit Menu (continued) 

 

 
 

Menu Selection Keyboard Description

Select changed ⎯ Selects all lines that have been changed 

Duplicate line Ctrl + D Copies the selected line to a new line  

Insert line ⎯ Places an empty line above the line where the 
cursor is placed  

Delete line ⎯ Removes the selected line(s) 

Go To… Ctrl + G On a document line window with multiple 
document lines, this command opens a dialog to 
allow the user to jump to a specific document 
line 



HUDCAPS Navigation Guide 

HUDCAPS Navigation Guide 10 Options Menu 

Section   7.   Options Menu 

 
 

Menu Selection Keyboard Description

Action Line Ctrl + Home Activates the Expert Action line 

Tables and Queries Ctrl + N Opens the Table/Query Listing window. This 
window is used to allow users to choose a specific 
table or query from a list 

PIH Section 8 Options ⎯ Table containing ACC Management and Pricing, 
Payments, and Year End Settlements default values

Choose Code... ⎯ Provides a list of valid codes and allows for 
selecting a code for the field where the cursor is 
positioned  

Field Description ⎯ Provides a description of the code where the cursor 
is positioned  

Open Related Table Ctrl + L Opens the table which corresponds to the field 
where the cursor is place (e.g. if the cursor is on the 
Fund field, the FUND Table will be accessed) 
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Section   8.   Window Menu 

 
 

Menu Selection Keyboard Description

Cascade ⎯ Arranges windows to overlap each other with the 
title bar of each window remaining visible 

Tile ⎯ Arranges the open windows in tiles across the 
screen 

Arrange icons ⎯ Arranges the icons on the HUDCAPS desktop 
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Section   9.   Help Menu 

 
 

Menu Selection Keyboard Description

Help on Current 
Window 

F1 Provides Help on the current window 

Online Error Guide ⎯ Accesses the Online Error Guide 

Contents — Provides a list of Contents available under the Help 
selection 

Search for Help on... — Provides information on all HUDCAPS processes 

How to Use Help — Provides information on using the Help facility 

HUDCAPS Notices  Provides notices about HUDCAPS such as dates 
and times when the system will not be available. 

HUDCAPS News — Provides current and back issues of the HUDCAPS 
Newsletter that is distributed monthly 

About... ⎯ Displays information regarding the version and 
release of HUDCAPS for Windows 
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Section   10.   Batch Menu 

 
 

Menu Selection Keyboard Description

Batch Ticket Ctrl + B Opens the Batch Ticket window. Provides 
information related to a batch of documents (e.g., 
total dollar amount and number of documents 
entered)  

Edit ⎯ Applies all system checks and edits to the batch 
ticket. If errors are found, the appropriate messages 
are displayed. Otherwise, the document is ready for 
approval by an Authorized Supervisor. 

Process ⎯ Applies all system checks and edits to the batch 
ticket and updates all related tables and queries. 

First Document Ctrl + PgDn Scrolls forward to next document in the batch  

Last Document ⎯ Moves to the last document in the batch  

Insert Document ⎯ Inserts a new document into the batch  
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Section   11.   Document Menu 

 
 

Menu Selection Keyboard Description

Edit Ctrl + E Applies all system checks and edits to the 
document. If errors are found, the appropriate 
messages are displayed. Otherwise, the document is 
scheduled for off-line processing.  

Process Ctrl + R Applies all system checks and edits to the 
document;  if no errors are found, updates  
HUDCAPS queries immediately. 

Schedule ⎯ Schedules the  document for off-line processing. 

Hold Ctrl + H Places active document on hold until further 
updates are made. 

Approvals F3 Allows you to perform the following functions: 

  Show Displays current approval status of 
the document 

  Apply Applies level of approval applicable 
to the document and User ID 

  Remove Removes level of approval applicable 
to the User ID 
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Section  11.  Document Menu (continued) 
 

 
 

Menu Selection Keyboard Description

Override... ⎯ Allows you to override certain errors based on the 
level of override authority. 

Delete ⎯ Marks the active document as “deleted” on the 
Document Listing. Deleted documents should be 
purged after three to five days. Refer to Deleting a 
Document from the Document Listing Procedures in 
this manual 

Undelete ⎯ Unmarks the document for deletion on the 
Document Listing. Undeletes a document marked as 
“deleted” by putting it on Hold status. 
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Section   12.   Actions Menu 

 
 

Menu Selection Keyboard Description

Display Ctrl + S Scans the HUDCAPS tables and displays all entries 
that match the specified key fields  

Display More Ctrl + R Displays the next screen of entries (if applicable)  

Get Specific Ctrl + G Scans the HUDCAPS tables and displays matching 
entry based on the specified key fields. Get 
Specific requires that all key fields be entered  

First Ctrl + T Displays the first entry in the active table  

Scroll Back Page Up Shows the previously displayed entries  

Scroll Forward ⎯ Moves forward through the displayed entries  

Add Ctrl + A Adds new records as entered on tables by the user 
into the system 

Change ⎯ Changes records already in the system 

Delete ⎯ Deletes records from the system 
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Section   13.   Document Listing Fields Descriptions 

A.  The following table explains the key fields on the Document Listing. 
 

Data Field Description
Batch ID Batch ID of the document being processed 

Document ID Document ID of the document being processed. See the 
section Document Numbering in this manual. 

Status Current Status of the document: 

 ACCPT Accepted update pass 

 SCHED Accepted edit pass and scheduled for 
overnight processing 

 HELD Held in Document Listing 

 REJCT Rejected during edit or overnight process 

 DELET Unaccepted document deleted 

 PD HD Batch accepted through Edit and put on 
hold 

 PEND1 Document pending approval 

 Approvals Applied Indicates the approvals applied and needing to be 
applied to a document. Approvals applied may contain 
four different codes: 

  0 Approval not necessary 

 A Awaiting approval 

 Y Approval applied 

 N Approval not applied 

Last Date Last date the document was changed  

Last User First four user ID characters of the last user to enter or 
update the document 

Process Date Date document was processed or will be processed in 
HUDCAPS 

 
 

B. The New... and Open... buttons will access the New Document/Batch or Open 
Document/Batch screen, respectively, and the Process button will process the selected 
document. 
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Section   14.   Modifying a Document 

A.  A document can be modified to change incorrect data entry. Examples of incorrect data entry 
include entering too much money on a document, entering too little money on a document, or 
assigning/distributing money to an incorrect location. To modify a document process an 
identical document with a line action of Change. 

  

B.  Access the corresponding query to determine the current amount and location of funds. 

 

C. Refer to the Procedures section for the corresponding budget level needing modification. 
Enter the appropriate data exactly as you would a new document, except for the following: 

• Select Change for the Line Action on the Header and Budget Line(s) tabs. 

• To modify a dollar amount, enter the amount of the increase or decrease in the 
Distribution Quarter Inc/Dec field on the Budget Line(s) tab (use the minus sign for a 
decrease). 

•  

NOTE The amount must include a decimal and cents (enter two zeros if it is an even dollar 
amount). 

 

D.  Process the document as you normally would. 

  

E.  Access the corresponding query to verify that the amount has been modified and is correct. 
 

NOTE If data has been incorrectly entered down more than one budget level, you must start 
the modification at the lowest level. (Example: If a mistake occurred on the B5 level, 
and was processed through the SA level, you must first modify the SA level, then the 
B6 level, then the B5 level) If you reverse a document completely, you must process a 
new document(s) through the appropriate level with the correct data. 
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Section   15.   Duplicating and Inserting Lines 

 
A. Duplicating and inserting lines can be used to apply funds from the same fund code to 

multiple areas by means of one document. This function will save steps and time in 
processing funds when done correctly. 

B. Duplicating lines will copy your current Budget Line(s) tab in full, including all the data you 
have already entered on the existing tab. By duplicating your line, you may save time by only 
needing to change one or two fields while carrying over the remaining fields that do not need 
to be changed. This process may be especially beneficial on the B6 or SA levels where most 
of the data on the Budget Line(s) tab will be the same for each new distribution, assignment, 
or subassignment. 

C. Inserting lines will create a new, blank Budget Line without any data. This process is 
beneficial if most of the data on the Budget Line(s) tab will be different, or if you are 
concerned about forgetting to change particular fields which should differ from the previous 
line. 

D. It is very important that you edit your document after each new line has been entered before 
moving on to the next line. By doing so, you will be able to easily find and resolve any errors 
on the document.  

E.  Perform the following steps to duplicate or insert lines on the Budget Line(s) tab: 
 

1. Select Edit from the Main menu. 
  

2. Select Duplicate line or Insert line from the Edit menu. 
  

3. Select OK when the small window with the i in the quotation bubble appears. 
  

4. Place the mouse arrow on the down arrow at the lower right corner of the window.  
Click and hold until you have scrolled down to the new or duplicated line. 

 

NOTE It is VERY important that you scroll down to the new or duplicated line before entering 
or changing data. The system does not save or process any data until you tell it to 
process. If you enter or change data on the existing line instead of scrolling down to the 
new or duplicated line, you will edit your already entered data without saving or 
processing it.  
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Section  15.   Duplicating and Inserting Lines (continued) 

 
F.  Enter or edit the new data on the new line (Example: If you are processing an SA document 

to assign money from the same fund to multiple field offices, you would only change the 
dollar amount you are assigning, and the field office to which you are assigning it. All other 
fields will stay as they are.). 

 
G.  Edit the document after entering or editing data on each new line (this is a very important 

step in that it will make finding errors much easier than if you wait until you have entered 
data on multiple lines). 

 
H. Process the document as you normally would after entering all the lines. 
 

Note Once you process the document, you will not be able to change or add to the document. If 
you process the document before adding or duplicating all the lines you need to, you will 
have to start a new document to process the remaining lines. 

 

I.  To delete a line that has been inserted or duplicated, see the following page on Deleting 
Lines. 
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Section   16.   Deleting Lines 

A. Deleting lines are used to delete budget lines that have been inserted or duplicated. If data 
has been entered incorrectly or if you want to remove an entire line, you can delete the line 
with this function. 

B.  Perform the following steps to delete lines on the Budget Line(s) tab: 
 

1.  Click on the budget line to be deleted (you will see a bold black border appear around the 
chosen budget line screen). 

 
2.  Select Edit from the Main menu. 

 
3. Select Delete lines from the Edit menu. 

 
4. When the message, “Do you really want to delete the selected lines?” appears, select Yes. 
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Section   17.   Changing Your Password  

 
A.  HUDCAPS periodically will prompt you to change your mainframe password. You can also 

change your HUDCAPS password whenever you wish (the first time you log onto 
HUDCAPS, you will have to change both your mainframe and your HUDCAPS passwords.) 
The new password must be between 6-8 characters long. On both windows, the Mainframe 
Sign On window and the HUDCAPS Security window, you can choose the Help button for 
online assistance for logging on to HUDCAPS and changing your password. 

  

B.  To change your mainframe password, click on the HUDCAPS for Windows icon from the 
Start, Programs, Program menu. The Mainframe Sign On dialog box appears. Enter your 
mainframe User ID and Password. Also enter a new password in the New Password field, 
and type it again in the Verify field. Choose the OK button. 

  

C.  If HUDCAPS prompts you to change your password after you have entered your mainframe 
User ID and Password, simply enter a new password in the New Password field, type it again 
in the Verify field, and choose the OK button.  

 

D. To change your HUDCAPS password, open the HUDCAPS application and log onto the 
mainframe, as described above. The HUDCAPS Security dialog box appears next. Enter your 
HUDCAPS User ID and Password and enter a new password that is 6-8 characters long in 
the New Password and Verify field. Choose the OK button. Now that you have changed your 
HUDCAPS password, you must enter your User ID and new password in the User ID and 
Password fields, then choose the OK button. This opens the HUDCAPS application. 
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Section   18.   Deleting a Document from the Document Listing 

 
A. Users can access rejected documents from the Document Listing and edit certain fields 

associated with the document. For example, if a user incorrectly enters the Allotment Holder 
and the document is rejected in the edit process, he or she can open the document from the 
document listing, correct the error, and edit the document again. Documents that are rejected 
and are not reused to correct and approve should be deleted from the HUDCAPS document 
listing. 

B.  To delete a document from the Document Listing: 
 

1.  Select File from the Main menu. 
 

2.  Select Document Listing from the File menu. 
 

3.  Press the Tab key 3 times so the cursor is in the first field under the Document ID field 
name. 

 
4.  Enter the Document Type (Ex: AA—Appropriation/Apportionment, PA—Appropriation 

Approval, etc.). 
 

5.  Press the Tab key. 
 

6.  Enter the Assistant Secretary code. 
 

7.  Press the Tab key. 
 

8.  Enter the Document Number (Ex: 0HA0000017). 
 

9.  Select Actions from the Main menu. 
 

10. Select Display from the Actions menu. 
 

11. When you see the document you are looking for, click once on the left mouse button to 
select it (the document line will be gray). 

 
12. Select Document from the Main menu.
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Section  18.   Deleting a Document from the Document Listing (continued) 

 
13. Select Delete from the Document menu. 

 
14. When the Delete Batch/Document window appears, choose the OK button. 

 

15. The Message Box will appear with the message DOCUMENT MARKED FOR 
DELETION. Close the Message Box by choosing the Close button. 

 

NOTE To see the updated status of the document that was deleted, select Actions from the 
Main menu, then select Display from the Actions menu. 
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Section   19.   HUDCAPS GUI and System Navigation 

A.  Through the use of a graphical user interface, users can customize how they view information in HUDCAPS. 
Windows in HUDCAPS include several tools to help manipulate the size and location of the information. 

 

Window 
Item

Symbol Function

Control Box  Closes the window by double clicking on it. 

Title Bar ⎯ Lists name of window. Click and hold on the Title bar 
to move the window. 

Scroll Bars 

 
 

Moves the view of the window without changing the 
window’s shape. Use the arrows to view items outside 
the window or drag the elevator to scroll. This item is 
located along the side vertical scroll bar and the 
bottom horizontal scroll bar of a window. 

Min/Max  
buttons 

 The minimize button (left) changes the window into an 
icon. The maximize button (right) changes the window 
to the size of the full screen. 

Push Button  Performs the action labeled on the button. 

Radio Button  

 

Represents set of mutually exclusive options selected 
by clicking on the desired option or by pressing the 
space bar after you tab to the item. 

Check Box  Represents a yes/no decision. Select or deselect a 
checkbox by pressing the spacebar after tabbing to the 
item or by pointing the mouse arrow on the box and 
clicking once. 

Tabs  Allows users to switch between panels on a window. 

Drop-down list  Accesses a list of field selections when clicked on 
once. 

Search icon 
 

Opens a Choose Code window which provides a list of 
valid codes for a field when clicked on once. 

Key Fields 
 

Identifies key fields on a table which are required to 
display a record. 

ToolTip  
 

Identifies which document line the cursor is on when 
on the lines tab of a multiple document. 
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Section   20.   Exiting HUDCAPS 

A. From the File menu, select Exit to exit HUDCAPS and sign off of the mainframe. 
 

 
 
 

B. Select Yes to exit or select No to return to HUDCAPS for Windows. 
 

 
 
 

C. As the system signs off, the following message appears: 
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Section   21.   Keyboard Commands 

A. To move to a desired point within a window, either click on that point with the mouse or use 
the cursor movement keys. To learn about keys that perform actions in HUDCAPS for 
Windows, see Using Shortcut Keys in HUDCAPS in this Procedures Manual. 

Key Action    

 The <Cursor Up> key moves the cursor up one line within a scrollable window. Within a 
group of radio buttons, this key moves the cursor to the previous button. 

 The <Cursor Down> key moves the cursor down one line within a scrollable window. 
Within a group of radio buttons, this key moves the cursor to the next button. 

 The <Cursor Left> key moves the cursor one character to the left within the current field. It 
will not move the cursor between fields. Within a group of radio buttons, this key moves 

the cursor to the previous button. 

 The <Cursor Right> key moves the cursor one character to the right within the current field. 
It will not move the cursor between fields. Within a group of radio buttons, this key moves 

the cursor to the next button. 

Tab The <Tab> key moves the cursor to the next field within a window. 

Shift-
Tab 

Holding down the <Shift> key while simultaneously pressing the <Tab> key moves the 
cursor to the previous field within a window. 

Home Within a text field, the <Home> key moves the cursor to the beginning of that field. 

End Within a text field, the <End> key moves the cursor to the end of that field. It moves you to 
the right-most choice within a group of choices. 

Enter Performs scan on the active query using the entered required (key) fields. 

 
 
 

 Desired Menu Item Shortcut Key 

Actions Menu Alt + A 

Batch Menu Alt + B 

Document Menu Alt + D 

Edit Menu Alt + E 

File Menu Alt + F 

Help Menu Alt + H 

Options Menu Alt + O 

Windows Menu Alt + W 
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Section   22.   Using Shortcut Keys in HUDCAPS 

 

A.  HUDCAPS for Windows includes several shortcut keys that allow the user to execute an 
action without having to access the menu items. These actions can be executed by pressing 
the Ctrl (Control) key plus the corresponding key on the keyboard simultaneously. The 
following table lists the actions that can be executed by pressing the shortcut key listed: 

 

Action Shortcut Key 

Go to the Associated Batch Ticket Ctrl + B 

Copy data from a field (after highlighting) Ctrl + C 

Edit a Document Ctrl + E 

Close any Table or Document Ctrl + F4 

Go to a Specific Document Line (Documents Only) Ctrl + G 

Get a Specific Record (on Tables and Queries Only) Ctrl + G 

Put a Document on Hold Ctrl + H 

Access the Action Line Ctrl + L 

Open the Tables/Queries Listing Ctrl + N 

Print Screen Ctrl + P 

Go to the Next Document Ctrl + PgDn 

Go to the Previous Document Ctrl + PgUp 

Process a Document Ctrl + R 

Display the next Record Ctrl + R 

Display a Record Ctrl + S 

Find the first Record Ctrl + T 

Cut data from a field (after highlighting) Ctrl + X 

Paste data to a field after Cutting or Copying Ctrl + Y 

Reset radio buttons to their original state Del 

Approve and Process a Document in One Step F3 

Scroll to the next record PgDn 

Scroll to the Previous Record PgUp 
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Section  22.   Using Shortcut Keys in HUDCAPS (continued)  

 

B.  In addition to executing actions by using key strokes, users can access the items on the main 
menu by using key strokes instead of the mouse. Any items on the main menu can be 
accessed by pressing the Alt key and then pressing the underlined letter of the menu you 
want to access. The following table lists the shortcut keys that can be selected to choose a 
menu: 

 
C.  Once the item on the main menu has been chosen, users can choose any item in that menu by 

pressing the key that is underlined. For example, selecting Alt + D will access the Document 
menu. The user can then press the “E” key to select the Edit menu items from the Document 
menu. 
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Section   23.   Accessing the Online Help at Any Time 

 

A.  One last key to note is the F1 key. The F1 key will open the Online Help corresponding to 
the document, table, or query that the user is currently viewing when it is chosen. The Online 
Help contains information on all documents, tables, and queries, as well as, procedures and 
relevant miscellaneous information in HUDCAPS. 

 

 

 

 


